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2.  APPLICABILITY 

 

This Manual applies to Ethernet option boards for our 1/8 DIN size digital panel meters and 

counters, to our DIN-rail Ethernet transmitters, and to our DIN-rail Ethernet-to-serial device 

server. These modules serve as Ethernet Nodes and are as follows: 

• Our LNET Ethernet option board plugs into a host 1/8 DIN digital panel meter or counter, and 

provides an RJ45 connector for a 10/100BaseT Ethernet interface. Before using this board with 

your meter, verify that the meter label states “Series 2”. The host meter can be ordered with a 

choice of displays, signal conditioner boards, relay output boards, and analog output boards.  

• Our LNET485 Ethernet-to-serial device server option board also plugs into a host meter. It 

provides an RJ45 connector for a 10/100BaseT Ethernet interface, plus an RJ11 connector to 

serve as a device server for up to 31 meters on an RS485 bus. RS485 wiring is via commercial 

straight-through 6-wire data cables. The host meter can be ordered with a choice of displays, 

signal conditioner boards, relay output boards, and analog output boards. 

• Our LTE Series DIN-rail Ethernet transmitter provides an RJ45 connector for a 10/100BaseT 

Ethernet interface instead of the screw terminals for RS232 / RS485 serial communications of 

our LT Series transmitters. Our transmitters accept the same signal conditioner boards as our 

1/8 DIN size meters and counters. An isolated 4-20 mA analog output and dual relays are 

standard. The Ethernet circuitry is on the transmitter main board. Power over Ethernet (PoE) 

operation is jumper selectable with the DC power option (10-48 Vdc). 

• Our LTNET485 DIN-rail mounted Ethernet-to-serial device server provides an electrically 

isolated 10/100BaseT Ethernet interface via an RJ45 Ethernet connector, plus an RJ11 

connector and screw terminals to serve as a device server for up to 31 meters and transmitters 

on an RS485 bus. The RJ11 connector and screw terminal are wired in parallel. This DIN-rail 

mounted server is the preferred Ethernet gateway for a bank of transmitters with screw 

terminal data connectors. Even though it looks like a transmitter, the LTNET485 does not 

accept a signal conditioner board.  

Ethernet Nodes and instruments attached via RS485 to our device server Nodes can be accessed 

over a LAN or a WAN once the Nodes have been configured via our PC-resident Node Manager 

Software (see Section 7) or the Web Server (see Section 8) which is built into all Nodes. Once 

communications have been established, the instruments associated with the Nodes can be set up 

using our Instrument Setup Software (see Section 9), for example to scale the input and define 

setpoints for relay operation. Custom software can also be written by users as described at the 

end of this manual. 

Instruments from other manufacturers can be operated on an RS485 bus supported by our 

Ethernet-to-serial device server if the host computer uses the Modbus TCP protocol and com-

mands are issued suitable for these instruments. 
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3.  ETHERNET PRIMER & DEFINITIONS 

 
An Ethernet node is an Ethernet connection point. Node (with a capital “N”) refers to our Ethernet 

nodes. These run special firmware, which allows them to be discovered and configured using 

built-in Web Server Software or PC-resident Node Manager Software. Configuration data is stored 

in flash memory of the Node. 

A Server Node interfaces the Ethernet to multiple meters and transmitters on an RS485 bus. 

Node Manager Software is a Windows-based application that runs on a host PC and can be used 

to find and configure the Nodes. It automatically discovers all Nodes on a LAN or WAN, plus any 

devices connected to Server Nodes via an RS485 bus. It configures each Node by setting up 

communication parameters, naming the Node and associated devices, entering email addresses 

for alarm notification and data requests, selecting the Node’s time zone for time-stamping of 

emails and streaming data, and upgrading the Node’s firmware. Once the configuration data has 

been stored in flash memory of all Nodes, Node Manager Software can be closed. 

Web Server capability and a built-in firmware resident website allow each Node to perform most 

of the same functions as Node Manager Software (but not upgrading the Node’s firmware). A PC 

with a browser interface is required, such as Internet Explorer. Once a Node is attached to a LAN, 

the router that controls the LAN will assign a unique IP address to the Node (such as 192.168.0 

.19). Entering that IP address as a URL into the browser will open the website and discover all 

other Nodes on the LAN. 

A MAC address is an identifier assigned to each Node at our factory for permanent identification. 

That address is 6 bytes long and is unique in the world. 

An IP address (e.g., 192.168.0.19) is used to address Ethernet nodes on a LAN or WAN. An IP 

address can be Static and Public so that it can be addressed on a WAN. An IP address can also be 

dynamic as assigned by a router or by another DHCP for addressing the same LAN. Dynamic IP 

addresses on a LAN are also called private or local IP addresses. 

Port numbers are associated with each software application and serve as passwords for two-way 

packet transmissions. Default port numbers assigned to our Nodes are TCP port 502502502502 for Modbus 

TCP transmissions, UDP port 63179631796317963179 for UDP transmissions, and TCP port 80808080 for web server 

http:// transmissions. 

A router is a device that bridges two networks and forwards data packets to their destinations on a 

LAN based on their IP addresses and port number. Normally a router will use its built-in DHCP 

server capability, and network devices will use their built-in DHCP client capability, to negotiate 

private (or local) IP addresses for all devices on the LAN.  

DHCP server capability is built into all of our Nodes. When a Node fails to find a DHCP server that 

responds to its request for a private IP address, it assigns one. When several Nodes fail to receive 

a Private IP address, they mutually agree to make one of the Nodes a temporary DHCP server that 
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assigns a Private IP address to each device on the network. Built-in DHCP server capability allows 

Nodes to constitute themselves into a network and be connected directly to a host computer when 

no router or dedicated DHCP server is present. The time for Nodes to decide that there is no 

dedicated DHCP server is about 25 seconds. The Nodes are intelligent enough that when another 

DHCP server comes online, the temporary DHCP server Node relinquishes its unique status and 

seamlessly becomes a client network device. 

On a Local Area Network (LAN) where the host computer is part of the network, the Nodes are 

discovered by our Node Manager Software, which then lists the Nodes’ MAC address and private 

IP address. When one of the discovered Nodes is selected, all of the active devices on that Node 

are discovered, and the following information is listed for each device: device name, address, type, 

revision, signal conditioner, protocol, communication settings, and reading format. 

On a Wide Area Network (WAN), such as the Internet, the host computer is outside of the LAN 

and therefore must know the public IP address of the LAN router to discover the Nodes on the 

LAN.  

Emails with device readings and alarm status can be sent to a computer or to a smart phone in 

the form of text messages when devices on a Node encounter an alarm condition, go on- or off-

line, or at selected intervals. Emails containing device readings can also be sent from the Node in 

response to email requests. Each Node can be configured with an email account, recipient email 

addresses, and notification intervals. Emails can be sent as text messages to any smart phone to 

notify plant operators of alarm conditions wherever they are. 

Communication protocols supported by our Nodes are ModbusModbusModbusModbus    RTURTURTURTU, Modbus Modbus Modbus Modbus ASCIIASCIIASCIIASCII, Custom Custom Custom Custom 

ASASASASCIICIICIICII (a simpler protocol than Modbus), and Modbus TCPModbus TCPModbus TCPModbus TCP for Ethernet communications. When 

used with an LNET485 or LTNET485 Ethernet-to-serial device server Node, Modbus TCP is 

seamlessly converted by the Node to Modbus RTU or Modbus ASCII for communication with 

meters and transmitters on an RS485 bus. 
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4. JUMPER SETTINGS & FIELD WIRING 

 

1. Safety Warnings 
 

 

Warning: Use of a device in a manner other than specified may impair the protection of the device 

and subject the user to a hazard. Visually inspect the unit for signs of damage. If the unit is 

damaged, do not attempt to operate it. 

Caution:  

Meters, transmitters and the LTNET485 DIN-rail Ethernet-to-serial device server may be powered 

with AC (mains) from 85-264 Vac with the high voltage power supply option, or from 12-32 Vac 

or 10-48 Vdc with the low voltage power supply option. Verify that the proper power option is 

installed for the power to be used. These products have no AC (mains) switch. They will be in 

operation as soon as power is connected. 

• The 85-264 Vac or 95-300 Vdc  (mains) connector is colored Green to differentiate it from 

other input and output connectors. The 12-32 Vac or 10-48 Vdc connector is colored Black. 

• For safety reasons, do not make signal wiring changes or connections when power is applied 

to an instrument. Make signal connections before power is applied. If reconnection is required, 

disconnect the AC (mains) power before such wiring is attempted.   

• To prevent electrical or fire hazard, do not expose the instrument to excessive moisture or 

temperature. 

• Do not operate the instrument in the presence of flammable gases or fumes, as such an 

environment constitutes an explosion hazard.  

• Meters are designed to be mounted in a metal panel. Verify the panel cutout dimensions, and 

mount according to instructions. 

• LTE transmitter and the LTNET485 DIN-rail Ethernet-to-serial device server are designed to be 

clipped to a 35 mm DIN rail. 

Symbols Used 

 

Caution (refer to accompanying 
documents)  

Both direct and alternating 
current. 

 

 
Caution, risk of electric shock. 

 
Earth ground terminal. 

 
Equipment protected throughout by double 
insulation or reinforced insulation.  

Signal ground terminal. 

 

Operating Environment: 

Our meters, transmitters and the LTNET485 DIN-rail Ethernet-to-serial device server are Class II 

(double insulated) equipment designed for use in Pollution degree 2. 
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2.  Hardware Overview 

The Ethernet connector for all of our Nodes is provided by an RJ45 jack, Green and amber LEDs 

on the jack indicate network operation: 

1) Following power-up, the green and amber LEDs are on 

steady until an IP address has been assigned to the Node. 

2) Once an IP address has been assigned to the Node, the 

amber LED is turned off. It will light up whenever the Node 

detects data packet activity. 

3) When the Node has made a TCP connection, the green LED 

alternates on (1 sec) and off (1 sec), while the amber LED is 

on steady.  

Ethernet cables (CAT5 or better) can be straight-through or crossover. Our Nodes automatically 

adapt for either. 

An LNET option board is used in our Ethernet panel meters and counters. This board has an RJ45 

jack for direct connection to a computer, router, switch or hub via an Ethernet cable.  

An LNET485 option board is used in our Ethernet-to-serial device server meters. This board has 

an RJ45 jack to the Ethernet plus an RJ11 jack which supports up to 31 remote meters on an 

RS485 bus. The remote meters must be equipped with our L485 RS485 serial communication 

board with dual RJ11 jacks. These allow the remote meters to be daisy-chained using readily-

available, straight-through, 6-wire data cables with no need for hand-wiring or an RS485 hub.  

LTE Series Ethernet transmitters feature an RJ45 jack for the Ethernet in lieu of the 6 screw 

terminals that would otherwise be standard for RS232 and RS485 with our transmitters.  

LTNET485 DIN-rail Ethernet-to-serial device servers feature an RJ45 jack to the Ethernet, an 

RJ11 jack for connection to remote meters via an RS485 bus using 6-wire data cables, plus 5 

screw terminals for connection to LT Series transmitters via discrete wires to an RS485 bus. All 

our LT Series transmitters come standard with a screw terminal RS485 interface.  

Half or full duplex RS485 communications (2 data wires + ground or 4 data wires + ground) can 

be selected via jumpers on our LNET485 or LTNET485 Ethernet-to-serial device servers and on the 

devices on the RS485 bus. If the RS485 bus is implemented with screw terminals, half-duplex 

selection can also be made by shorting ATX to ARX and BTX to BRX at the screw terminals. 

Shorting these wires at the connector is electrically equivalent to using jumpers on the board.  

RS485 Termination Resistors should be inserted via jumpers on the server end and on the last 

device on an RS485 line longer than 200 feet (60 m). Do not install more than these two sets of 

jumpers on an RS485 line, as this could add an excessive resistive load and draw down the 

voltage on the line. First try operating without termination resistors. 

Ethernet Indicators 

8
7
6
5
4
3
2
1

Amber LED      

Green LED

RX -

RX +
TX  -
TX +
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3.  Connection of 1/8 DIN meters 

Basic Ethernet panel meters use an LNET Ethernet option board with an RJ45 jack for direct 

connection to a computer, router, switch or hub via an Ethernet cable.  

RJ45

Ethernet 
Interface
Board

 

Basic Ethernet meter board  

No jumpers needed. 

Ethernet-to-serial device server meters with an LNET485 option board can function as normal 

meters for measurement and control purposes and also as a device server. This option board 

features and RJ485 jack to the Ethernet plus an RJ11 jack which can support up to 31 remote 

meters via an RS485 bus in daisy chain fashion.  

RJ45Ethernet-to-
RS485 Server
Board

bd RJ11ac

 

Ethernet-to-serial device server meter board 

Full duplex:  No jumpers for short cable runs. 

  Add a + c for long cable runs. 

Half duplex:  b + d. Add a for long cable runs. 

   

6
5
4
3
2
1

ISO GND
BRX (RX+)
ARX (RX-)
ATX (TX-)
BTX (TX+)
ISO GND

 

6
5
4
3
2
1

ISO GND
 
 

TX- / RX-
TX+ / RX+
ISO GND

 

Full duplex operation Half duplex operation 

Wiring of RJ11 jack of Ethernet-to-serial device server board 

The meters on an RS485 bus need to be equipped with our L485 RS485 digital interface board 

with dual 6-pin RJ11 jacks, not our LMOD RS485 digital interface with dual 8-pin RJ45 jacks. The 

dual 6-pin RJ11 jacks on the L485 RS485 board are wired in parallel to allow multiple meters to 

be daisy-chained using readily-available 6-wire data cables with no need for hand-wiring or an 

RS485 hub. The outer two wires are used for ground. 

Use 6-wire, straight-through data cables, not 4-wire telephone cables or crossover cables, all the 

way from the device server to the last device on the RS485 bus. Connect ATX to ATX, BTX to BTX, 

etc., with no crossover as you go from device to device. 
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a cb d

RS485 Interface
Board, Rev. J

RJ11

RJ11

 

RS485 meter board, Rev J 

(shipped after April 2009) 

Full duplex:  No jumpers for short cable runs. 

  Add b + d for long cable runs. 

Half duplex: a + c. Add d in last meter for long cable 

runs. 

c

a

d

RJ11

b

fe

RS485 Interface
Board, Pre J

RJ11

 

RS485 meter board, pre-Rev J 

(shipped before April 2009) 

Full duplex:  b + e bias jumpers on one meter only. 

  Add a + d in last meter for long cable runs. 

Half duplex: b + e bias jumper on one meter only. 

  c + f for half duplex operation. 

  Add d in last meter for long cable runs. 

RS485 boards used in remote meters 

. 
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4.   Connection of Transmitters   

4.1  LTE Ethernet Transmitters 

P1  Power  input
3   Power GND
2   AC neut or -DC   
1   AC high or +DC      

P4  Analog
output (standard)
  
P3  Solid state
relays (normally
open, standard)

P5  Signal 
input &
excitation 
output

  Ana out -    1
Ana out +    2
Alarm 2    1
Alarm 2    2
Aalrm 1    3
Alarm 1    4

Signal 
conditioner
board

RJ45 P2   Ethernet
E2

b

ad

c

a
b
c

E3

E1 E4 ab

Reset

 

LTE Ethernet transmitters feature an RJ45 Ethernet connector, which allows the transmitter to be  

connected directly to a computer, router, switch or hub via an Ethernet cable. The RJ45 connector 

replaces the screws terminals that would otherwise be provided for RS485 or RS232 data I/O. An 

isolated 4-20 mA, 0-20 mA or 0-10V analog output is standard, as are dual 120 mA solid state 

relays for alarm or control. Signal conditioner boards are available for all popular industrial analog, 

frequency and pulse-type transducer signals. 

To reset the transmitter (same as power-up), press the Reset button. 

To reset communications to 9600 baud, command mode, Custom ASCII protocol, and Address 1, 

place a jumper at E1 and power up the transmitter.  

Analog Output Jumpers 

Current (0-20 mA) E2 a + d 

Voltage (0-10V) E2 b + c 
 

Excitation Output* Jumpers 

5V, 100 mA E3 a + c; E4 a 

10V, 120 mA E3 a + c; E4 b 

24V, 50 mA E3 b, E4 none 
 

*  Attempting to draw more than the rated transducer excitation output current will shut down the 

output. 
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4.2  LTNET485 Ethernet-to-RS485 Device Server 

3   Power GND
2   AC neutral or -DC   
1   AC high or +DC     

5   ARX (RX-)
4   ATX (TX-)
3   GND
2   BRX (RX+)
1   BTX (TX+) 

RJ11

RJ45 P4   Ethernet

P3   RS485

a
b

c

d

E6

P2

P1

 

The LTNET485 Ethernet-to-serial device server features an RJ45 Ethernet connector for direct 

connection to a computer, router, switch or hub via an Ethernet cable, plus an RJ11 RS485 

connector which is wired in parallel to five screw terminals. These additional connections allow 

the server to support a total of 31 meters and transmitters on an RS485 bus. 

The RJ11 connector is designed for use with our meters having the dual 6-pin RJ11 RS485 com-

munication option. These jacks allow multiple meters to be daisy-chained using readily-available  

6-wire straight-through data cables with no need for hand-wiring or an RS485 hub.  

The five screw terminals are designed for use with our non-Ethernet transmitters, which provide 

screw terminals for RS485 I/O as a standard feature. Using screw terminals on the server and 

transmitter ends allows data transmission via five discrete wires, with no need for adapters. 

Serial Signal Duplex Jumpers Termination Resistor* 

RS485 
Full None E6 a + c 

Half E6 b + d ** E6 c 

*  Only install termination resistor(s) if the device server is at one end of an RS485 line longer 

than 200 feet (60 m). 

**  Or externally jumper BTX to BRX and ATX to ARX (same effect as internal jumpers). 
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4.3  LT Series DIN-Rail Transmitters on an RS485 Bus 

P4  Analog
output (standard)
  
P3  Solid state
relays (normally
open, standard)

P5  Signal 
input &
excitation 
output

  Ana out -   1
Ana out +   2
Alarm 2   1
Alarm 2   2
Aalrm 1   3
Alarm 1   4

Signal 
conditioner
board     RS485

6   N/C
5   ARX
4   ATX
3   GND
2   BRX
1   BTX

3   Power GND
2   AC neut or -DC   
1   AC high or +DC

RS232    
TX
RX
NC
GND
GND
NC

P1  Power  input

E1 E4 ab

a
b

c

dE2

b

ad

c

a
b
c

E3
E6

P2  Communications   

Reset

 

LT Series transmitters on an RS485 bus offer RS485 data I/O as a standard feature along with an 

isolated 4-20 mA, 0-20 mA or 0-10V analog output and dual 120 mA solid state relays for alarm or 

control. Signal conditioner boards are available for all popular industrial analog, frequency and 

pulse-type transducer signals. 

For Ethernet connectivity, connect up to 31 LT Series transmitters to our LTNET485 DIN-rail 

Ethernet-to-serial device server using discrete, parallel wires in daisy chain fashion from the 

server to each transmitter.  

• For fullFor fullFor fullFor full----duplex communications, duplex communications, duplex communications, duplex communications, use five wires to connect BTX to BTX, BRX to BRX, ATX to 

ATX, ARX to ARX, and GND to GND, all in daisy chain fashion without crossover. 

• For halfFor halfFor halfFor half----duplex communications,duplex communications,duplex communications,duplex communications, use three wires to connect A to A, B to B, and GND to GND. 

Serial Signal Duplex Jumpers Termination Resistor* 

RS485 
Full None E6 a + c 

Half E6 b + d ** E6 c 

*  Only install termination resistor(s) if the transmitter is the last device on an RS485 line longer 

than 200 feet (60 m). 

**  Or externally jumper BTX to BRX and ATX to ARX (same effect as internal jumpers). 

To reset the transmitter (same as power-up), press the Reset button.  

To reset communications to 9600 baud, command mode, Custom ASCII protocol, and Address 1, 

place a jumper at E1 and power up the transmitter, then remove the E1 jumper.  

Other jumper positions are as for our LTE Ethernet Transmitter Node (Section 4.1). 
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5.  NETWORK CONFIGURATION EXAMPLES 

 

 

Example 1.  The host computer is connected directly to a meter with an LNET Ethernet I/O 

board or to an LTE transmitter via a single Ethernet cable. Upon power-up, the Node will wait 

about 25 seconds to decide that no dedicated DHCP server is present, then set itself up as a 

DHCP server. It will assign a local IP address to itself and to the host computer, creating a 

LAN consisting of the Ethernet Node and computer. This simple LAN allows a computer to 

program a single meter or transmitter. 

 

Example 2.  On the same LAN are the host computer and multiple Nodes consisting of a mix 

of LTE transmitters plus meters and counters with an LNET Ethernet I/O board. The Nodes 

will automatically be discovered and can then be configured by Node Manager Software 

running on the host computer. They can also be discovered and configured by using the 

Web Server built into all Nodes. Simply use a web browser like Internet Explorer and enter 

the public IP address of the router or the IP address of any Node in the network. 
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Example 3.  The host computer is connected to a first meter with an LNET485 Ethernet-to-

serial server board via an Ethernet cable. This first meter can take measurements and also 

serves as the host for an Ethernet-to-serial server board. That board is acts as the Ethernet 

gateway for the host meter and for up to 31 other meters via commercial 6-wire RS485 data 

cables in daisy-chain fashion. Upon power-up, the Node will wait about 25 seconds to decide 

that no dedicated DHCP server is present, then sets itself up as a DHCP server. It will assign 

a local IP address to itself and to the computer, creating a LAN consisting of the Ethernet 

board and host computer. The Ethernet board also serves as an RS485 server to address all 

meters on the RS485 line. 

 

 

Example 4.  The host computer is connected to an LTNET485 DIN-rail Ethernet-to-serial 

device server in a DIN rail mount package. This device server provides an RS485 interface 

for up to 31 RS485 devices, which can be a mix of transmitters and meters. Connection to 

transmitters can be via 5 discrete parallel wires for full-duplex RS485, or via 3 discrete 

parallel wires for half-duplex RS485. Connection to meters (not illustrated) is via 6-wire data 

cables and RJ11 jacks. After waiting 25 seconds, the device server automatically sets itself 

up as a DHCP server and as an Ethernet Node, assigning a local IP address to itself and to 

the computer. 
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Example 5.  On the same LAN are the host computer and a variety of Ethernet devices, 

which can include our LNET meters, LTE transmitters, and LTNET485 device servers. The 

host computer and all Ethernet devices on the same LAN are peers using the same level. If 

the router or switch connected to the computer has DHCP server capability, local IP 

addresses for all downstream devices will automatically be assigned by the router or switch. 

Otherwise one of our Nodes will assume the role of DHCP server.  

 

Example 6.  In this example, the host computer communicates with remote meters and trans-
mitters via the Internet using an LTNET485 Ethernet-to-serial device server Node on the 
remote side. Setup of the LTNET485 requires knowledge of the public IP address of the router. 
Knowledge of any IP address on the remote LAN suffices if the Web Server built into the Node 
is used. All our Ethernet devices on the remote LAN will then be automatically discovered, plus 
all our devices on any RS485 bus.    
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6.  HOW TO SET UP NODES WITH NODE MANAGER PC SOFTWARE 

 

Nodes can be configured using Node Manager Software, a Windows application, as follows: 

1. Connect all Nodes and RS485 device. The Nodes can be on the same LAN as the host 

computer or be connected to it via a WAN (Internet). They can also be connected directly to 

the host computer using a straight-through or cross-over Ethernet cable. Connection via a 

LAN or a straight-through cable is recommended for initial Node setup. 

2. Install Node Manager Software on the host computer. This software can be downloaded 

from our website at no charge. To install, click on the .exe file and follow the prompts. The 

recommended installation directory is C:\Program Files\NodeMgr.  

3. Launch NodeMgr.exeLaunch NodeMgr.exeLaunch NodeMgr.exeLaunch NodeMgr.exe by clicking on that file name or on the corresponding desktop icon that 

you may have created. A welcome splash screen will be displayed briefly, followed by the 

Node Discovery screen.  

4. Discover all Nodes on the network (Node Discovery tab). This is done automatically by 

Node Manager for all Nodes on a LAN upon entering the Node Discovery screen. When the 

Nodes are on a WAN (Internet), the public IP address of the router must be entered. Your 

Windows firewall settings must allow Node Manager to run, or Nodes will not be discovered. 

5. Discover all devices attached to each server Node (Device Discovery tab). This is done 

automatically and continuously for the Node’s serial settings over the selected range of 

device addresses, also for all possible combinations of protocol, parity and baud rates of 

4800, 9600 and 19200 if this option is checked.  

6. Force serial settings of discovered devices to those of the server Node (Device Discovery 

tab). Select the desired protocol, baud rate and parity for the Node, then check a box to force 

the discovered devices to the Node’s settings.  

7. Enter the time zone for each Node (Time Zone tab). This time zone plus UTC/GMT time 

obtained by the Node over the Internet will allow the Node to send correctly time-tagged 

readings and alarm notifications via email or streaming data. 

8. Enter email addresses for each Node (E-Mail Addresses tab). These addresses will receive 

readings and alarm notifications via email messages from the Node, as programmed. 

9. Set up the email account for each Node (E-Mail Account tab). Enter the email address, 

incoming mail server and outgoing mail server so that the Node can receive and send email. 

10. Set up TCP and UDP ports (Advanced Settings tab). Enter the TCP port, a second UDP port, 

and a TCP connection timeout. Also use the Advanced Settings screen to write Node setup 

data to disk and read it from disk. 

11. Upgrade the Node’s firmware (Firmware Upgrade tab) at no charge from our website when 

a new Node firmware version is available.  
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GENERAL INFORMATION 

F1 Help Key. Pressing the F1 Key for any tab or control item in the Node Manager program 

brings up comprehensive help information for that item. To avoid executing a command item, 

right-click on the command button before pressing the F1 key.  

Get and Put Commands. The Get command reads configuration data from the Node for 

display on the host computer. The Put command writes configuration data from the host 

computer into the Node. If a Put command is not executed before exiting a Node Manager 

screen, any entered changes will be lost. A warning message will be displayed first. 

Password Protection 

A Node can operate with or without Password protection. If a Node is configured with Pass-

word protection, Node Manager allows node configuration data to be read with a Get com-

mand without a Password; however, any changes to Node configuration with a Put command 

require a valid password. For each session of Node Manager, the Password only needs to be 

entered the first time a Put command is issued for that Node.  

If Password protection is not desired, “NoPassword” appears as the Password. This allows 

Node configuration changes to be made with only a “Continue” command from the Password 

screen. 

Passwords consist of 1 to 16 case-sensitive alphanumeric characters. These are encoded for 

storing in the Node and for transmission over the Ethernet. Nodes can each have a different 

Password, or the same Password can be used for all Nodes.  

A Node operating without Password protection can be changed to Password protection by 

unchecking the “Do not use Node Password protection” box and then entering the desired 

Password. If the Node is operating with Password protection, the Password can be changed by 

clicking on the “Change Password” button after first entering the current Password. The new 

Password is stored in the Node when the Continue command is clicked.   

If you have forgotten your password, call the factory number shown in the opening screen of 

Node Manager. Please have Node Manager running, the Node connected, and the Password 

screen open when you call. 
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1. CONNECTION METHOD TAB 

 

The PC-to-Node connection can be made by two methods: 

Method 1:  Method 1:  Method 1:  Method 1:  PCPCPCPC    running running running running Node Manager Node Manager Node Manager Node Manager Software isSoftware isSoftware isSoftware is    the the the the sssservererverervererver,,,,    Node Node Node Node isisisis    the the the the cccclientlientlientlient....    

The PC sends a broadcast signal to all of the Nodes via the UDP protocol, and requests them 

to send back their IP and MAC addresses. Node Manager then lists all of responding Nodes, 

and the user chooses the one of interest. Node Manager then notifies that Node to send a 

request for a TCP connection. When the Node Manager receives it, it sends an acknowledge-

ment to the Node, and the connection is completed. This method has the advantage that the IP 

Addresses of all of the Nodes are discovered, and these do not need to be known beforehand. 

The Node Discovery tab is associated with this Connection Method. 

Method 2: Node is Method 2: Node is Method 2: Node is Method 2: Node is the the the the server, PC running server, PC running server, PC running server, PC running Node Manager Node Manager Node Manager Node Manager Software isSoftware isSoftware isSoftware is    the cthe cthe cthe clientlientlientlient....    

To create a connection with a Node, the Node Manager must then know the Node's IP Address 

and TCP Port number. With this information, it sends a request for a TCP connection directly 

to the Node, which is constantly listening. The Node sends an acknowledgement, and the TCP 

connection is completed. This method does not require the use of the UDP protocol to make a 

connection. If the Node's IP Address and TCP Port are unknown, Method 1 can be used for 

Node discovery, and Method 2 can then be used. 
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2. NODE DISCOVERY TAB, LAN 

 

Nodes on a Nodes on a Nodes on a Nodes on a local local local local LANLANLANLAN are automatically discovered under the Node Discovery tab when “LAN” 

is selected under “Select Network Type”. Nodes can be rediscovered at any time by pressing 

the “Repeat Node Discovery” button. Your Windows firewall settings must allow Node 

Manager Software to run, or Nodes will not be discovered. Check with your IT department if 

you suspect a firewall issue. 

Node discoveryNode discoveryNode discoveryNode discovery uses UDP Port 63179631796317963179. If this port is blocked by a router, go to the “Advanced 

Settings” tab. There you can change the Local TCP port number and enter a second UDP port 

number, which will then be used for discovery in addition to 63179. 

A discovered Node must be selected before it can be configured.A discovered Node must be selected before it can be configured.A discovered Node must be selected before it can be configured.A discovered Node must be selected before it can be configured. To select a Node, click 

anywhere on its line. The line should then be highlighted, the “Node Connection Status” field 

should change from “Closed” to “Connected”, and the RJ45 jack of the connected Node should 

show a steady amber LED and a blinking green LED. If the selected node is already connected 

to another host computer, a new connection cannot be made, and a Node Busy message will 

be displayed. 

Shown at the bottom of the screen for each selected Node are the Node Name, Node  

MAC #, Node IP address, Node Type, and Node firmware revision. 
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3. NODE DISCOVERY TAB, WAN 

 

Nodes on Nodes on Nodes on Nodes on a remote LANa remote LANa remote LANa remote LAN are automatically discovered via the Internet by selecting “WAN” 

under “Select Network Type”, entering the Public IP Address of the router to which the Nodes 

are connected, and pressing on “Repeat Node Discovery”. 

Node discoveryNode discoveryNode discoveryNode discovery uses UDP Port 63179631796317963179. If this port is blocked by the router, go to the 

“Advanced Settings” tab. There you can change enter a second UDP port number, which will 

then be used for discovery in addition to 63179. All of our other Nodes must also be changed 

to the new UDP port. 

Once discovered,Once discovered,Once discovered,Once discovered, individual Nodes can be selected for configuration by clicking on their line, 

as described on the previous page. Shown at the bottom of the screen for each selected Node 

are the Node Name, Node MAC #, Node IP address, Node Type, and Node firmware revision. 
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4. DEVICE DISCOVERY TAB, NOT A DEVICE SERVER NODE 

 

If the selected Node If the selected Node If the selected Node If the selected Node is an LNET485 Ethernet I/O board of a meter, only that single host meter 

will be discovered as the device for that Node. The Node itself will be shown with an artificially 

assigned address of 0. The address of the discovered device will be a number from 1-31 for 

device addressing with the Custom ASCII protocol or from 1-247 with the Modbus protocol. 

The address of the Node hosting device is always shown in parentheses ( ).  

To change the name of the Node or of a discovered device, select the item, enter the desired 

name, and press on “Save Name”. The new name will then be stored in the Node and will be 

included in emails and streaming data.  

Set the same serial settingsSet the same serial settingsSet the same serial settingsSet the same serial settings for the Node and the host device. Make your selections under 

“Node’s Settings” (protocol, baud rate, parity), check the box “Force discovered devices to 

Node’s settings”, then press “Put” to save your data in the Node. 
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5. DEVICE DISCOVERY TAB, DEVICE SERVER NODE 

 

If the selected NodeIf the selected NodeIf the selected NodeIf the selected Node is the LNET485 Ethernet-to-serial device server option board of a meter or 

is a DIN-rail LTNET485 Ethernet-to-serial device server, up to 31 RS485 physical devices may 

be discovered, including the host meter of an LNET485 option board. Since Modbus allows 

addresses of 1-247, there can be unused addresses. 

Devices are being discovered continuouslyDevices are being discovered continuouslyDevices are being discovered continuouslyDevices are being discovered continuously as the server Node tries different combinations of 

device address, protocol, baud rate, and parity. All devices with baud rates of 4800, 9600 or 

19200 can be discovered as a group, regardless of their protocol, parity or address, by 

checking the box “Discover Baud rate settings 4800 - 19200” and then pressing “Put”. Devices 

with baud rates below 4800 baud can be included in the discovery process by entering their 

serial settings under “Node’s Settings” and then pressing “Put“. The combination being tried at 

any moment for device discovery is displayed under “Discovery Trial” in the upper right of the 

screen. To speed up discovery, enter the narrowest possible address range, then press ”Put”. 

Also avoid searching at baud rates below 4800 if these are known not to apply. 

Set the same serial settingsSet the same serial settingsSet the same serial settingsSet the same serial settings for the Node and all listed devices. Make your selections under 

“Node’s Settings” (protocol, baud rate, parity), check the box “Force discovered devices to 

Node’s settings”, then press “Put” to save your data in the Node. 
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6. TIME ZONE TAB 

 

A time stamp is included in email messages and in streaming data sent by the Node. If the 

Node has a path to the Internet (also required for email), the Node will automatically obtain 

accurate UTC/GMT time (Coordinated Universal Time or Greenwich Mean Time) from an online 

time server. The Node’s time zone or the offset from UTC/GMT time must be also supplied 

using this screen. 

To set the Node’s time zone,To set the Node’s time zone,To set the Node’s time zone,To set the Node’s time zone, select the Region as “USA/Canada” or “Other”. If the selected 

Region is “USA/Canada”, the program offers eight selectable time zones, each with the cor-

responding offset from UTC/GMT in hours. The offset is corrected for Daylight Saving time if 

that box is checked. If the selected Region is “Other”, the offset from UTC/GMT needs to be 

entered in +/- hh:mm format. If the offset time for a particular region is unknown, go to an 

Internet source such as www.timetemperature.com. To enter your selections, press “Put”. To 

read previously entered selections, press “Get”. 

Note: Note: Note: Note: Only one instance of Node Manager can connect to the same Node at the same time. 
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7. EMAIL ADDRESSES TAB 

 

Readings and alarm notificationsReadings and alarm notificationsReadings and alarm notificationsReadings and alarm notifications can be emailed by the Node to a list of email addresses 

stored in the Node. 

Node’s E-Mail Address List displays email addresses stored in the Node that will be receiving 

emails from the Node. To retrieve that list from the Node, press on “Get”. To delete an address 

from the Node, highlight it, press on “Delete from List”, then press on “Put”. 

Address Book is a new window (see next page) which displays email addresses stored in the 

host computer under Node Manager. To reduce typing time, these addresses can be down-

loaded into multiple Nodes, not just the currently active Node. To remove an email address 

form Address Book, select it, then press on “Remove Selected Book Address”. To download 

email addresses from Address Book into the Node’s E-Mail Address List (shown above), select 

them, then press on “Add Selections to Node’s List”. This will close the Address Book window. 

To download the Node’s E-mail Address List to the Node, press on “Put”. 

Readings Email Notification Interval. The readings of all devices connected to the Node are 

emailed to all email addresses in the Node at this selected time interval. Reading emails are 

disabled by entering an interval of 0 (hours or minutes).  
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Alarm Email Notification Interval. An alarm notification email can be sent to all email 

recipients each time the alarm status of a device connected to the Node changes. To reduce 

the number of emails, this interval dictates the minimum time between consecutive emails. 

Alarm emails are disabled by entering an interval of 0 (hours, minutes or seconds).  

Alarm Dwell Time. To reduce the number of emails, an Alarm Dwell Time is set so that an 

email message is sent only when the changed alarm state has lasted longer than this dwell 

time. If the alarm state changes during the dwell time, the dwell timer is reset.  

Alarms of Interest. A device with alarms may have 2 or 4 alarms, some of which may not be 

of interest. To remove an alarm from Alarm Email Notifications, uncheck that alarm.  

Send Test E-mail sends a test email to all of the Nodes’ email recipients. 

Commands can be emailed to the Node with only these capitalized words in the subject line:  

LIST – Adds the sender’s email address to the email list in the Node. 

DELIST – Removes the sender’s email address from the email list in the Node. 

ACQUIRE –  Requests the last readings of all devices under this Node. 

IDENTIFY – Requests the MAC address of the Node. 

 

 

 

    

Note: Note: Note: Note: Only one instance of Node Manager can connect to the same Node at the same time. 
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8. EMAIL ACCOUNT TAB    

 

A Node must have its own email accountA Node must have its own email accountA Node must have its own email accountA Node must have its own email account so that it can send and receive emails. 

Node's E-Mail Address. Enter a unique email address for the Node so that it can receive email, 

then press on “Put”. That address will also be shown as the sender in emails from the Node.  

Server Information (Names). Enter names for the Incoming Mail (POP3) and Outgoing Mail 

(SMTP) servers for the Node. This information should be the same as for other email clients 

on the same network. In MS Outlook, it is found under Tools > E-mail Accounts. It should also 

be available from the network administrator or company IT department.  

Advanced User Checkboxes. If desired, IP addresses can be entered instead of names for the 

Incoming Mail (POP3) and Outgoing Mail (SMTP) servers, and server ports can be changed 

from their default settings. Standards are Port 110 for Incoming Mail and Port 25 for Outgoing 

Mail. While Outgoing Port 25 is the standard for sending email, it is also often used for 

sending spam, so Internet Service Providers may block it. If blocked, try Port 2525 or Port 

587. 

Note:    Only one instance of Node Manager can connect to the same Node at the same time. 
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9. ADVANCED SETTINGS TAB 

 

Change “Local TCP Port” from its default of 502 if that port value is blocked by your router. 

Change “Remote Node UDP Port 2” from its factory default of 63179 if that port value is 

blocked by your router. Node discovery will use both Node UDP Port 1 at 63179 and Node 

UDP Port 2 at the value set using this screen. 

Change “TCP Connection Timeout” from its factory default of 30 seconds if so desired. 

Minimum timeout is 16 seconds. Enter 0 to disable timeout. If no TCP activity is detected by 

the Node during the timeout, the TCP connection is broken by the Node. 

Set “Parent Meter Interrogation” to “Enabled” so that the Node will read data from its host 

meter or counter. Set it to “Disabled” if the host device is a remote serial display or a serial-to-

analog transmitter which does not supply data, otherwise the device will go into Reset. 

Press “Put” to save your Advanced Setting changes in the Node. 

Press “Read Node Setup File” to retrieve a previously saved Node setup file from disk.  

Press “Write Node Setup File” to save your current Node setup to disk.  

Enter the Static IP Address, Gateway and Subnet Mask if not supplied by a DHCP server. 
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10.  FIRMWARE UPGRADE TAB 

 

Node firmware upgrades are available from the factory at no charge and should be installed 

into each Node when available. Upgrading the firmware will not affect data stored in the Node.  

To see if a Node needs an upgrade, click on the Firmware Upgrade tab and note the revision 

of the currently installed firmware, such as EtherLN1_0_0.txt. Then go to the Software Down-

loads section of the factory website and note the latest posted revision. If it is has a higher 

number than the currently installed version, download it into a computer directory of your 

choice. This directory could be C:\Program Files\NodeMgr\, which is also recommended for the 

Node Manager executable file. 

To upgrade a Node, connect to the Node. Use the “Browse” button to locate your download 

directory. Select your downloaded firmware file and press on “Open”. Then press the “Start 

Firmware Upgrade” button. A red box will appear indicating “Upgrade in Process”. While this 

indication is present, do not turn off your computer or disconnect the Node, as this could 

corrupt the firmware of the Node. Once the upgrade has been completed (in about 5 seconds), 

the box will turn green. To repeat for other Nodes, connect to each Node, then repeat the 

upgrade process. 
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7.  HOW TO SET UP NODES WITH THEIR BUILT-IN WEB SERVER 

 
A Web Server is built into each or our Nodes and hosts a website with an IP address, which can 

be entered into the URL field of a browser (such as Internet Explorer) or be the destination of a 

web link. The Web Server offers the same Node discovery and setup functions as Node Manager 

Software, except that only Node Manager Software can be used for Node firmware upgrades. 

All web server pages offer online help. Simply click on the blue captions associated with each 

data entry field.  

How to get started:  

• Node access with browser on same LAN as the Nodes. Once the IP address of any of our 

Nodes has been entered into your browser, all other Nodes will automatically be discovered by 

our Web Server and will be listed in the Node Discovery web page. An easy way to discover a 

first Node IP address (as well as all other Node IP addresses) is to use our Node Manager 

Software, as explained in the previous section of this manual. 

• Node access over the Internet. If the browser is to access our Nodes on a remote LAN over 

the Internet, port forwarding must first be set up for the router that controls the remote LAN. 

The default port numbers programmed into our Nodes are UDP port 63179 for Node 

discovery, TCP port 502 for Modbus TCP, and TCP port 80 for http:// communications. If any 

of these ports are blocked by the router or a firewall, different port values can be entered into 

our Nodes, and you or your company’s IT department will then need to set up the remote 

router to forward these different port values. Once port forwarding has been set up, simply 

enter the public IP address of the remote router into your browser. This will open our Node 

Discovery web page, which lists all of our Nodes on the remote LAN. 
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1. NODE DISCOVERY Web Page 

 

 How to get here: Upon entering the public IP address of your router or the first IP address of a 

Node into your browser, this web page displays all LNET, LTE, LNET485 and LTNET485 Nodes on 

the same LAN as the router or first Node. 

NODE NAME: A Node’s default name is “Node” followed by the Node’s unique MAC address. This 

name may be changed by the user to a more descriptive name by clicking on SETUP. 

IP ADDRESS: The Node’s IP address, which can be entered into a browser such as Internet 

Explorer or be the destination of a web link.  

TYPE: The Node’s type (LNET, LNET485, LTE or LTNET485). LNET is an Ethernet communication 

board in a 1/8 DIN instrument. LNET485 is an Ethernet-to-RS485 device server board in a 1/8 DIN 

instrument. LTE is a DIN rail mounted transmitter with an Ethernet interface. LTNET485 is a DIN 

rail mounted Ethernet-to-RS485 device server. Clicking on TYPE brings up a FACTORY SETUP 

screen, which is password protected. 

FIRMWARE: The Node’s firmware version, which can be updated using Node Manager Software 

without loss of setup data. Check for the latest version, which can be downloaded from our 

website. 

SETUP: A link to the NODE SETUP web page, which allows changes to the Node’s time zone, 

name, LED status, and passwords. 

DEVICES: A link to the DEVICE DISCOVERY web page, which lists all Devices (or instruments) 

attached to the Node. With an LNET or LTE Node, this will be a single meter or transmitter. With 

an LNET485 or LTNET485 server Node, there can be a mix of up to 31 meters and transmitters on 

an RS485 bus. 

LAN: A link to the NODE DISCOVERY screen (this screen), which lists all Nodes on the LAN. 

DEVICES: A link to the DEVICE DISCOVERY screen, which lists all Devices attached to this Node. 
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2. NODE SETUP Web Page 

 

How to get here: From the top navigation bar of the selected Node. 

Background: A time stamp is included in email messages and in streaming data sent by the Node. 

If the Node has a path to the Internet (also required for email), the Node will automatically obtain 

accurate UTC/GMT time (Coordinated Universal Time or Greenwich Mean Time) from an online 

NTP time server. The Node’s time zone, daylight saving time status, and the offset from UTC/GMT 

time are supplied using this screen. 

Top row: Links to DEVICE INTERFACE SETUP, EMAIL SETUP, and NETWORK SETUP screens for 

this Node. 

TIME ZONE: Select one of the six listed North American time zones, or select "Other". This data will 

be used in the time stamp included in email messages and in streaming data sent by the Node. 

Press GO to enter any change.  

DAYLIGHT SAVINGS: Indicate whether or not GMT Offset (Sec) should be automatically corrected 

for daylight saving time, which causes the local clock to be adjusted forward one hour in spring 

and backward one hour in autumn. This correction is only applied if a North American time zone 

was selected. Press GO to enter any change. 

GMT OFFSET (SEC): When the Node has a path to the Internet (as required for email), it will 

automatically obtain accurate UTC/GMT time (Coordinated Universal Time / Greenwich Mean 

Time) from an online NTP time server. If a North American time zone was selected, this field will 

automatically display the offset in seconds from UTC/GMT time. If “Other” was selected, you need 

to enter the GMT offset in seconds. To obtain the required entry, do a Google search for "world 

time zones" and convert the listed offset in hours to seconds by multiplying by 3600. Press GO to 

enter any change. 
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CHANGE NODE NAME: Used to enter a descriptive name for the Node, such as "Tank 1 Level". If a 

custom entry is not made, the assigned default name is in the format Node :D4:20:38, where the 

word "Node" is followed by the Node’s MAC address. Press GO to enter any change. 

CHANGE LED STATES: Use the pull-down selections to change the color assignments of the two 

indicator LEDs on the RJ45 jack. Changing the color assignments may be used as a temporary 

diagnostic to identify a specific Node from its light pattern. Press GO to enter any change. 

Normal operation is a follows: 

1) Following power-up, the green and amber LEDs are on 

steady until an IP address has been assigned to the Node. 

2) Once an IP address has been assigned to the Node, the 

amber LED is turned off. It will light up whenever the Node 

detects data packet activity. 

3) When the Node has made a TCP connection, the green 

LED alternates on (1 sec) and off (1 sec), while the amber 

LED is on steady.  

CHANGE PASSWORD and CONFIRM PASSWORD: If you wish to password protect the Node, 

enter the same password in these two fields. A Node can operate with or without password 

protection. If a password has been defined using this screen, this password will be required for 

any change to Node Setup, including changing the password. Passwords consist of 1 to 16 case 

sensitive alphanumeric characters, which are encoded for storing in the Node and for trans-

mission over the Ethernet. Nodes can have the same or different passwords. If you have changed 

a password, you will be given a 5-minute grace period for the change to take effect. If you have 

forgotten your password, call the factory and ask for Ethernet Support. Please have the Node 

connected and the Node Setup screen open when you call. 
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3. DEVICE INTERFACE SETUP Web Page 

 
 
How to get here: From the top navigation bar of the selected Node. 

Background: The Device Interface Setup screen applies to the Node whose MAC address is shown 

in the top right of the screen. If the selected Node is an LNET Ethernet I/O board of a meter, only 

that single host meter will be discovered as the device for that Node. If the selected Node is an 

LNET485 or LTNET485 Ethernet-to-serial device server option board of a meter or is a DIN-rail 

Ethernet-to-serial device server, up to 31 physical devices may be discovered, including the Node 

itself. Since Modbus allows addresses of 1-247, there can be unused addresses. 

Top row: Links to the EMAIL SETUP, NETWORK SETUP, and NODE SETUP web pages for this 

Node. 

SELECT DEVICE: Click on the selector button to display all devices that have been discovered 

automatically for the selected Node. All device names are preceded by a number followed by an = 

sign. Click on a device name to select that device, and its name will then be shown in reverse font. 

You will then be able to make setup changes for the selected device using this screen. 



 34 

CHANGE DEVICE NAME: To rename a device, first select the device using the "Select Device" field 

to the left, then enter a new desired name and press GO. The new name will then appear under 

"Select Device" preceded by the device number and an = sign. For example, you may change the 

name of the first device to "Boiler 1 Pressure" to make reports more understandable. 

NODE PROTOCOL: Select Custom ASCII, Modbus RTU, Modbus ASCII, or a pass-through 

protocol indicated by ? for the device that has been selected under "Select Device". Press GO to 

enter any change. If only our devices are used, the node protocol, baud rate and parity are 

automatically selected in a plug-and-play mode as part of device discovery. Multiple devices that 

are interfaced to the same Node via an RS485 bus can each be set up with a different node 

protocol, baud rate and parity. This capability is normally only used to accommodate devices by 

other manufacturers. 

• If Modbus TCP is used to communicate over a LAN with the Node, this protocol is 

seamlessly converted by the Node to Modbus RTU or Modbus ASCII for communication 

with our meters and transmitters on an RS485 bus. 

• The Custom ASCII protocol is simpler than Modbus RTU or Modbus ASCII. 

• The ? protocol selection is a pass-through protocol where the Node simply passes through 

data packets to the LAN without modification in a tunneling mode. This should only be 

used to accommodate devices by other manufacturers.   

BAUD RATE: Select the baud rate for the device that has been selected under "Select Device". 

Press GO to enter any change. If only our devices are used, the node protocol, baud rate and 

parity are automatically selected in a plug-and-play mode as part of device discovery. 

• Multiple devices that are interfaced to the same Node via an RS485 bus can each be set up 

with a different node protocol, baud rate and parity. This capability is normally only used to 

accommodate devices by other manufacturers. 

• Available selections range from 300 to 614,400 baud. The factory default setting for our 

meters is 9,600 baud. Rates higher than 19,200 baud are not supported by our devices 

shipped prior to 2013, but may be supported by devices by other manufacturers. 

• Slow baud rates of 1,200 baud and below are not recommended, since these cause unne-

cessary transmission delays.  

PARITY: Use the "Parity" field to change the parity setting of the device that has been selected 

under "Select Device". Press GO to enter any change. If only our devices are used, the node 

protocol, baud rate and parity are automatically selected initially in a plug-and-play mode as part 

of device discovery. 

• Multiple devices that are interfaced to the same Node via an RS485 bus can each be set up 

with a different node protocol, baud rate and parity. This capability is normally only used to 

accommodate devices by other manufacturers. 

• If "Custom ASCII" is selected as under "Node Protocol", No Parity is automatically selected 

by the software.  
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ALARM NOTIFICATION (SEC): An alarm notification email can be sent to all email recipients each 

time the alarm status of a device connected to the Node changes. To reduce the number of emails, 

this interval in seconds dictates the minimum time between consecutive emails. Alarm emails are 

disabled by entering an interval of 0. Press GO to enter any change. 

ALARM DWELL TIME (SEC): An alarm dwell time can be set in seconds to reduce the number of 

emails sent by the Node. An email message will only be sent when the changed alarm state has 

lasted longer than the dwell time. If the alarm state changes during the dwell time, the dwell timer 

is reset. Press GO to enter any change. 

ALARM MASK: 1, 2, 3, 4: Check any boxes 1, 2, 3, 4 to receive alarm email mail notifications 

from any alarms 1, 2, 3, 4 the selected devices connected to the Node. If the device is one of our 

meters (DPM or counter), it can have 2 or 4 alarms. If it is one of our LT or LTE transmitters, it 

will have 2 solid state alarms. Not all alarms may be of interest for email notification. To remove 

an alarm from alarm email notifications, uncheck that alarm. Press GO to enter any change. 

DATA EMAIL INTERVAL (SEC): The data readings of all devices connected to the Node are emailed 

to all email addresses in the Node at this selected time interval. Data emails are disabled by 

entering an interval of 0. Press GO to enter any change. 

URL REFRESH (SEC): This is the time interval in seconds at the root pages for Node Discovery 

and Device Discovery self-refresh, thereby showing the latest Node and device discovery status. 

The default value is 16 seconds. Press GO to enter any change. 

Include 4,800/9,600/19,200 BAUDs when searching for devices? This selection applies to the 

discovery of Devices on the RS485 bus attached to an LNET485 or LTNET485 Ethernet-to-RS485 

Device Server Node. The Devices on the RS485 bus can each have their own communication 

setting (baud rate, parity, protocol, and digital address). They can be discovered if they have the 

same baud rate setting as the Device Server Node (from 300 or 19200 baud) or a baud rate of 

4800, 9600 or 19200 baud, if different. If NO is selected, only the Device Server Node’s baud rate 

is included in the search for Devices. If YES is selected, 4800, 9600 and 19200 baud are also used 

in the search for Devices. Press GO to enter any change.  

Up to 247 digital addresses are included in the search unless a more limited range of addresses 

has been programmed into the Node using Node Manager Software to speed up Device discovery.  

Force all our devices to the Node’s communication setting? All devices attached to an LNET485 

or LTNET485 Ethernet-to-RS485 Device Server Node can have their own communication settings 

(baud rate, parity, protocol, and digital address). Select YES to force all discovered devices on a 

device server Node to the Node’s communication settings, otherwise select NO. Press GO to enter 

any change. 
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4. EMAIL SETUP Web Page 

 
 
How to get here: From the top navigation bar of the selected Node. 

Background:  An email account can be set up for each Node. This allows the Node to send data 

readings at periodic intervals, when it encounters an alarm condition, when it goes on-or off-line, 

or in response to email requests. Commands can also be emailed to the Node with these 

capitalized words in the subject line:  

LIST – Adds the sender’s email address to the email list in the Node. 

DELIST – Removes an email address from the email list in the Node. 

ACQUIRE – Requests the last readings of all devices under this Node. 

IDENTIFY – Requests the MAC address of the Node. 

A powerful feature of our Nodes is the ability to send Alarm information to cell phones via text 

messages. This allows operators to receive alarm information within a couple of seconds 

wherever they are, even if they are in a meeting, at lunch, or outside the plant. Sending a text 

message in North America is as easy as sending an email. Specify the receiving address in the 

format below, which will vary with the cell phone carrier. “Number” is the 10-digit cell number 

without spaces or punctuation: 

• AT&T: number@txt.att.net 

• Qwest: number@qwestmp.com 

• T-Mobile: number@tmomail.net 

• Verizon: number@vtext.com 

• Sprint: number@messaging.sprintpcs.com 

• Sprint: number@pm.sprint.com 

• Virgin Mobile: number@vmobl.com 

• Nextel: number@messaging.nextel.com 

• Alltel: number@message.alltel.com 

• Metro PCS: number@mymetropcs.com 

• Powertel: number@ptel.com 

• Boost Mobile: number@myboostmobile.com 

• Suncom: number@tms.suncom.com 

• Tracfone: number@mmst5.tracfone.com 

• U.S. Cellular: number@email.uscc.net 
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Top row: Links to DEVICE INTERFACE SETUP, NETWORK SETUP, and NODE SETUP web pages. 

POP3 SERVER: The incoming mail server to be used for the Node. Enter the same name as for the 

other email clients on the same network, such as mail.mycompany.com. Press on the first GO to 

enter. 

POP3 USERNAME: The username to be supplied to retrieve incoming email. It is tied to the Node's 

specific email address and is normally supplied by the network administrator or company IT 

department. Press on the first GO to enter. 

POP3 PASSWORD: The password to be supplied to retrieve incoming email. It is tied to the 

Node's specific email address and is normally supplied by the network administrator or company 

IT department. Press on the first GO to enter. 

POP3 PORT: A number which identifies the type of incoming email port. Leave at 110, which is 

the normal number for a POP3 port. The POP3 protocol assumes that there is only one client con-

nected to the mailbox. On rare occasions, a network administrator or company's IT department 

may specify a different number. Press on the first GO to enter. 

POP3 INTERVAL (SEC): The interval in seconds at which to Node will check email. Enter 0 to 

disable email checking. The maximum interval is over 4 million seconds. Normally do not check 

email more often than every 60 seconds. Press on the first GO to enter. 

SMPT SERVER: The outgoing mail server to be used for the Node. Enter the same name as for the 

other email clients on the same network, such as mail.mycompany.com. Press on the first GO to 

enter. Press on the first GO to enter. 

SMPT EMAIL ADDRESS: The email address that will be shown as the sender of the email. A 

typical email address would be in the format user1@mycompany.com. Press on the first GO to 

enter. 

SMPT PORT: A number which identifies the type of outgoing email port. Normally leave the 

number at 25, which is the standard for sending email via SMTP. Since port is also often used for 

sending spam, Internet Service Providers may block it. If blocked, try Port 2525 or Port 587. 

Press on the first GO to enter. 

ADD NEW EMAIL ADDRESS: Write in each email address which is to receive emails from the 

Node, then press GO. Addresses should be in the format user@mycompany.com. All entered 

addresses will appear below the email entry field, each preceded by a DELETE box. 

DELETE: Check each box to the left of any previously entered recipient email address that your 

wish to delete from the Node, then press GO to execute. This will update the Email Setup screen. 

TEST EMAIL: Check the Test Email box, then press then press GO to execute. This will send a test 

email to all email recipients that have been defined using the ADD NEW EMAIL ADDRESS field to 

the left, thereby verifying email operation. 
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5. NETWORK SETUP Web Page 

 
  

How to get here: From the top navigation bar of the selected Node. 

Background:  Each Node has an IP address which is used to address the Node on a local area 

network (LAN) or on the Internet (WAN). An IP address can be static and public so that it can be 

addressed on over the Internet and have an associated domain name. It can also be a dynamic 

address assigned by a router or other DHCP server on a LAN. Such an address is also called a 

private or local IP address. Our Node-resident firmware automatically discovers the IP address of 

all Nodes on a LAN or WAN, plus any Devices on the RS485 bus connected to an Ethernet-to-

RS485 Device Server Nodes. 

Top row:  Links to DEVICE INTERFACE SETUP, EMAIL SETUP, and NODE SETUP web pages. 

REFRESH NET: Enter a checkmark and press GO to refresh the Node's IP address on command 

from the network. 

STATIC IP: Enter a static IP address for the Node if you want to be able to address the Node from 

anywhere over the Internet. An IP address is a 4-byte number (e.g., 192.168.0.57). Leave the 

entry at 0.0.0.0 if you want the IP address to be assigned dynamically by the router for the LAN on 

which the Node is located, or by the Node itself if there is no router or other DHCP server. Press 

GO to enter any change. 
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GATEWAY IP: Enter the static IP address of your LAN's gateway router if you want to be able to 

address your Nodes from anywhere over the Internet. This address is normally provided by your 

organization's IT department. Leave the entry at 0.0.0.0 if you do not want address your Nodes 

from anywhere over the Internet. Press GO to enter any change. A gateway router is a device 

which provides the entrance to a local area network (LAN). This is normally a router which assigns 

dynamic IP addresses and also serves as a firewall. A gateway can interface a first LAN to another 

LAN or to the Internet. 

SUBNET MASK: Enter the subnet mask for your LAN's gateway router if you want to be able to 

address Nodes on the LAN from anywhere over the Internet and if a subnet mask entry has been 

requested by your organization's IT department. A subnet mask is a way of telling your router 

which network addresses it can consider local and which are remote. Leave at 0.0.0.0 to disable 

the subnet mask feature. Press GO to enter any change. 

TCP TIME-OUT: Change “TCP Connection Timeout” from its factory default of 32 seconds if so 

desired. Minimum timeout is 16 seconds. Enter 0 to disable timeout. If TCP activity has not been 

detected by the Node for this timeout period, the TCP connection is broken by the Node. Press GO 

to enter any change. 

MODBUS TCP PORT: Enter the TCP port number of the Node or leave that number at 502 if you 

have no reason to change. Press GO to enter any change. The standard TCP port number for 

Modbus is 502. It is possible to use a different port number, provided that both the client and 

server can be set to use a different port number. This may not be possible, and in most cases it 

will be most convenient to just use the standard port number 502. Our Node discovery software 

uses TCP port 502 and UDP port 63179.  

HTTP PORT: Enter the HTTP port number of the Node or leave that number at 80 if you have no 

reason to change. Press GO to enter any change. By default, port 80 is used by URLs that begin 

with http:// and is the default port number for HTTP communications. Port 443 is used by URLs 

that begin with https:// . Only enter a port number other than 80 if that number has been blocked 

by the IT department and a different number has been supplied. If the port number is changed to 

anything other than 80, all web addresses that reference the Node must include that port number. 

DISCOVERY PORT: Enter a second UDP port number if required. Leave the UDP number at 63179 

if you do not require a second UDP port number. Press GO to enter any change. The TCP and UDP 

protocols specify a source and destination port number in their packet headers. A port number is 

a software construct associated with permissions for an application such as our Node discovery. 

Our Node discovery software uses TCP port 502 and UDP port 63179. If port 63179 is blocked by 

a router, this field can be used to enter a second UDP port number, which will then be used for 

Node discovery in addition to 63179. 

AUTO-DISCOVERY: This default selection permits the Node to broadcast a 70-byte self identifi-

cation message over the LAN every 15 seconds, a very light load on the network. This allows the 

Nodes to discover each other's IP Addresses, thereby greatly facilitating network setup and 

maintenance.   
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STEALTH MODE: This setting precludes the Node from broadcasting a 70-byte self-identification 

message over the LAN every 15 seconds. This setting should only be selected if such broad-

casting is not allowed by IT department policy, as it does not allow the Nodes to discover each 

other's IP Addresses. However, IP addresses can still be discovered by our PC-resident Node 

Manager software. 

NTP SERVER: Enter an NTP time server, if desired, other than www.pool.ntp.org. This is the 

default online NTP time server used to synchronize the clocks in our Nodes and also millions of 

other networked devices. It returns extremely accurate UTC/GMT time (Coordinated Universal 

Time or Greenwich Mean Time), which is then modified by our Nodes for the local time zone and 

is used to time and date stamp emailed and streamed reading data. Press GO to enter any change. 

NTP INTERVAL (SEC): Specifies how often the Node will correct its own quartz crystal clock by 

checking the NTP time server. The default interval is 86400 seconds, or one day. Press GO to 

enter any change. 
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6. DEVICE DISCOVERY Web Page 

 

How to get here: Select a specific Node on the NODE DISCOVERY PAGE and click on DEVICES or 

on NODE. 

Background: This screen displays all Devices (or instruments) discovered for the Node. If the 

Node is an LTNET Ethernet board in a meter or counter or is an LTE transmitter, only a single 

Device will be shown, namely the host meter, counter or transmitter. If the Node is LNET485 or 

LTNET485 Ethernet-to-RS485 Device Server, there can be up to 31 Devices, namely the host 

meter or counter plus up to 30 additional Devices on an RS485 bus. Hovering over any underlined 

item will bring up an informational bubble. 

NAME: The name assigned to the discovered Device using the DEVICE INTERFACE SETUP page. 

TYPE: The instrument type programmed into the Device by the factory. Choices are DPM for 

analog input (including panel instruments and transmitters), CTR for pulse input (including panel 

instruments and transmitters), and WT for meters with weighing firmware (panel instruments). 

DATA: The data transmitted by the Device. Setup of transmitted data can be by means of Instru-

ment Setup Software (panel instruments and transmitters) or front panel keys (panel mounted 

instruments). Hover for data labels. For example, hovering over “+2.001 / +2.001 / +2.001” brings 

up the bubble “Reading / Peak / Valley”. 

ALARM:  State of up to 4 alarms, where 0 indicates no alarm and 1 indicates an alarm state. If the 

Device is one of our panel instruments, it can have 2 or 4 alarms. If it is one of our LT or LTE 

transmitters, it will have 2 alarms. Setup of alarms can be by means of Instrument Setup Software 

(panel instruments and transmitters) or front panel keys (panel mounted instruments). 
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9.  INSTRUMENT SETUP SOFTWARE 

 

Instrument Setup software running on a host computer is the preferred tool to set up devices on 

the network (meters, counters, timers and transmitters). That software allows uploading, editing 

and downloading of setup data, execution of commands under computer control, listing, plotting 

and graphing of data, and computer prompted calibration. It also displays jumper locations, for 

example to set up signal ranges, which cannot be done with software. 

To install Instrument Setup software, download IS2.exe (Version 3.0.0 or higher) onto your PC 

from our website or CD. Double-click on the file to unzip it into a special directory, such as 

c:\temp. Double-click on setup.exe to install the software on your PC.  

Before running Instrument Setup software, run Node Manager Software to discover and confi-

gure all Nodes on the network, discover all devices associated with each Node, and set up the 

same serial communications for each device. Then close Node Manager. 

To establish communications with Instrument Setup, assure that power is applied to all meters 

and transmitters on the network. Start Instrument Setup by clicking on Start => Programs => IS2 

=> IS2 or on the desktop shortcut that you may have established. In the resulting Communications 

screen, click on “Ethernet”. This will open a Node Discovery screen similar to the one under Node 

Manager. All discovered Nodes will be listed. 

  

• To select a meter or transmitter, highlight its associated Node under the Node Discovery tab, 

then click on the Device Discovery tab. All discovered meters and transmitters will be listed. 

• To work on a discovered device, select it, then click on the “Main Menu” button.  

• To retrieve device setup information from the device, click on Device => Get Setup.  

• To retrieve device setup information from disk, click on File => Open Setup. 

• To view and then edit that the retrieved information, click on View => Setup.  

• To download the edited information back into the device, click on Device => Put Setup. 

• To save the edited information to disk, click on File -> Save Setup.  
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You will find that Instrument Setup software is very user friendly, with separate tab-selectable 

windows for Input+Display, Scaling, Filter, Relay Alarms, Communications, Analog Output, and 

Lockouts. If the required hardware, such as the analog output board, is not sensed, the corres-

ponding tab will be grayed out. Uploading and downloading setup files from a host PC can be a 

major time saving when multiple meters or transmitters have to be set up in the same way. 

Additional Features 

• The Commands pull-down menu allows execution of certain meter functions by using a 

computer mouse. You can reset individual meter functions, display current or peak readings, 

and enter numbers to be displayed on a remote meter. The Commands pull-down menu is 

grayed out unless a Get Setup has been executed. 

 

Plot 

* 

Graph 

• The Readings pull-down menu provides three formats to display device data on the PC 

monitor. Use the Pause and Continue buttons to control the timing of data collection, then 

press Print for a hardcopy using your PC printer. 

• List presents the latest readings in a 20-row by 10-column table. Press Pause at any time to 

freeze the display. Press Print for a hardcopy. List can capture peak readings. 

• Plot generates a plot of readings vs. time in seconds. It effectively turns the DPM-PC combi-

nation into a printing digital oscilloscope. 

• Graph generates a histogram, where the horizontal axis is the reading and the vertical axis is 

the number of readings. The display resizes itself as the number of readings increases. 

• The Jumpers pull-down menu shows required board jumper positions. 

• The Calibration pull-down menu allows easy calibration of voltage and current ranges for the 

DC, load cell, and AC RMS signal conditioner boards. The PC first recognizes the type of board, 

then prompts you to apply specific jumpers and calibration signals. Press Ready to take a 

reading. Press Repeat to take more readings. When you have decided on which reading to 

accept, press on the number 1 through 10 of that reading. Additional calibration software is 

available online. 



 

 

26.  WARRANTY   

 
 
Yokogawa Corporation of America warrants its products against defects in materials or 
workmanship for a period of one year from the date of purchase.   

In the event of a defect during the warranty period, the unit should be returned, freight prepaid 
(and all duties and taxes) by the Buyer, to the authorized Yokogawa distributor where the unit 
was purchased. The distributor, at its option, will repair or replace the defective unit. The unit 
will be returned to the buyer with freight charges prepaid by the distributor. 

LIMITATION OF WARRANTY 

The foregoing warranty shall not apply to defects resulting from: 

     1. Improper or inadequate maintenance by Buyer. 
     2. Unauthorized modification or misuse. 
     3. Operation outside the environmental specifications of the product. 
     4. Mishandling or abuse. 

The warranty set forth above is exclusive and no other warranty, whether written or oral, is 
expressed or implied. Yokogawa specifically disclaims the implied warranties of merchant-
ability and fitness for a particular purpose. 

EXCLUSIVE REMEDIES 

The remedies provided herein are Buyer’s sole and exclusive remedies.  In no event shall 
Yokogawa be liable for direct, indirect, incidental or consequential damages (including loss of 
profits) whether based on contract, tort, or any other legal theory. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Yokogawa Corporation of America  Y800Ethernet      22 April 2015 


